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1. Introduction 
 

1.1 Add-on Module RF-IMP 

Many standards consider imperfections in analysis of second order effects. For this purpose, 
you can select between two options: You can define equivalent loads, which is provided for 
example in the standards DIN 18800 Part 2, Section 2, EN 1992-1-1:2004-12 or EN 1993-1-1: 
2005-07, or you can create a pre-deformed initial structure by moving FE nodes according 
to the standard provision. Add-on module RF-IMP includes both options.   

Initial deformations should be determined in unfavorable direction of action. For simple 
frameworks, you are able to define imperfections manually. However, this procedure is not 
sufficient for more complicated structures, such as with surface and volume elements. The 
rules of equivalent load calculation exist for members only. RFEM allows you to generate 
imperfections in the form of equivalent structure by using the deformation mode or the 
buckling mode of the structure. 

You can quickly, and consequently economically, examine different cases by generating im-
perfections in RF-IMP. After that, the procedure in the most unfavorable direction is assured 
according to standards. Implementation of buckling stress curves of the profiles according 
to EN 1992-1-1:2004-12, EN 1993-1-1:2005-07 or DIN 18800 is very comfortable while de-
fining equivalent member structure. 

If you enter a displacement and an initial curvature, RF-IMP generates imperfections in criti-
cal directions and transfers them to RFEM. Then you can find imperfections in a separate 
load case and join them to a load group. By using the pre-deformed initial structure, you 
implement shifted FE nodes into parameters of the load group. The advantage is that you 
can determine different pre-deformed initial structures in one model while keeping the 
structural input data. 

You can export tables directly to MS Excel or OpenOffice.org Calc for further manipulation 
or archiving. 

As other add-on modules, RF-IMP is fully integrated into RFEM. This add-on module repres-
ents a product part of RFEM, not only by its visual appearance. You can comfortably gener-
ate all equivalent imperfections by using results from RFEM (deformations under load cases, 
load groups and load combinations), RF-STABILITY (buckling shapes) and RF-DYNAM (eigen-
modes). 

 

We wish you much success and delight when working with our module RF-IMP. 

Your DLUBAL ENGINEERING SOFTWARE team 
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1.2 RF-IMP Team 
The following people were involved in the development of the RF-IMP module: 

Program coordination 
Dipl.-Ing. Georg Dlubal 
 Dipl.-Ing. (FH) Younes El Frem 

Programming 
DiS. Jiří Šmerák 
Ing. Roman Svoboda 

 

Program design, dialog figures and icons 
Dipl.-Ing. Georg Dlubal 
MgA. Robert Kolouch 

Ing. Jan Miléř 

Program supervision 
Ing. František Knobloch 
Ctirad Martinec 

 

Manual, help system and translation 
Dipl.-Ing. (FH) Robert Vogl 
Ing. Dmitry Bystrov 
Jan Jeřábek 
Ing. Jakub Harazín 

Ing. Ladislav Kábrt 
Mgr. Petra Pokorná 
Dipl.-Ing. Veronika Erlebachová 
Ing. Jana Sejkotová 

Technical support and quality management 
Dipl.-Ing. (BA) Markus Baumgärtel 
Dipl.-Ing. (BA) Sandy Baumgärtel 
Dipl.-Ing. (FH) Matthias Entenmann 
Dipl.-Ing. Frank Faulstich 
Dipl.-Ing. (FH) René Flori 
Dipl.-Ing. (FH) Walter Fröhlich 
Dipl.-Ing. (FH) Alexandra Lazar 

M.Sc. Dipl.-Ing. (FH) Frank Lobisch 
Dipl.-Ing. (FH) Alexander Meierhofer 
Dipl.-Ing. (BA) Andreas Niemeier 
M.Eng. Dipl.-Ing. (FH) Walter Rustler 
M.Sc. Dipl.-Ing. (FH) Frank Sonntag 
Dipl.-Ing. (FH) Christian Stautner 
Dipl.-Ing. (FH) Robert Vogl 

 

1.3 Using the Manual 
All general topics such as installation, user interface, evaluation of results and output are 
described in detail in the RFEM manual; hence, we omit them in this manual. On the con-
trary, we focus concentration on typical features of the add-on module RF-IMP. 

During the description of RF-IMP, we use the sequence and structure of the input and out-
put dialogs. The text of the manual shows the described buttons in square brackets, for ex-
ample [Details]. At the same time, they are pictured on the left. Additionally, the used ex-
pressions for dialog boxes, tables and menus are set in italics to clarify the explanations. 

We also put into this manual the index for fast finding of some terms. If you do not find the 
requested ones, please check our website www.dlubal.cz where you can go through our 
FAQ pages by selecting particular criteria. 
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1.4 Starting RF-IMP Add-on Module 
You can choose one of the following options in RFEM to start the add-on module RF-IMP. 

Main menu 
Start the module by the command from the RFEM main menu 

Additional Modules → Others → RF-IMP. 

 
Figure 1.1: Main menu: Additional modules → Others → RF-IMP 
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Navigator 
You can also start the module RF-IMP in the Data navigator by selecting the folder  

Additional Modules → RF-IMP. 

 
Figure 1.2: Data navigator: Additional Modules → RF-IMP 
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2. Input Data 
Entering the input data for generation takes place in tables. You can use helpful function 
[Pick] for graphical selection of members or sets of members. 

After starting RF-IMP, the navigator, which appears in a new window on the left, organizes 
both dialogs. You can find a list with possibly existing generation cases above the navigator 
(see chapter 4.1, page 25). 

While starting RF-IMP for the first time in the RFEM program, the add-on module automati-
cally loads following input data: 

• Members and sets of members 

• Load cases and load combinations 

Control the tables either by clicking their names in the RF-IMP navigator or by using buttons 
displayed on the left margin. You can also list the dialogs forward and back by pressing the 
function keys [F2] and [F3]. 

Click [OK] to save the input data and to close the add-on module RF-IMP or click [Cancel] to 
close the add-on module without saving the data. 
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2.1 General Data 
Determine the input for generation of imperfections and the type of generation in the table 
1.1 General Data. 

 
Figure 2.1: Table 1.1 General Data 

Generating imperfections according to 
At first, select which results you want to use for generation of imperfections, resp. of pre-
deformed initial structure. You can choose one of three options. 

Deformation from RFEM 
Determine the load action in the list Load Case, LG or CO. 

Take into account a special feature while selecting a load combination. There are two dif-
ferent results for each of x-values – maximal and minimal superposition of actions. There-
fore, you can select one of two options in the list of load combinations: CO+ (maximum) 
and CO- (minimum) as shown in the picture on the left. 

According to the standard DIN 18800 Part 2, el. (202), equivalent geometric imperfections 
are related to the lowest buckling eigenmode. In principle, you should create a particular 
load case of imperfections for each load in the critical direction with the equivalent defor-
mation mode. Generation of cases in RF-IMP (see chapter 4.1, page 25) provides you a pos-
sibility to create suitable imperfections based on different deformations. 

Buckling shape from module RF-STABILITY 
You can determine imperfections – according to the standard DIN 18800 Part 2, el. (202) – 
by fitting them, as precisely as possible, to the lowest stability mode. However, you need 
the licensed RF-STABILITY add-on module to have an access to stability modes. 

Enter the number of a relevant stability mode in the list No. and select the resulting case 
from RF-STABILITY in the list Case.  
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Eigen vibration from module RF-DYNAM 
You can base imperfections, resp. pre-deformed initial structure, on an eigenmode from the 
add-on module for dynamic analysis. According to the license that you keep at disposal, 
you can select the RF-DYNAM 2000 or the RF-DYNAM 2007 add-on module. 

Specify determining case from dynamic analysis in the list Case. In the list No., enter the 
number of an eigenvibration, which you want to use for the generation of imperfections. 

If the add-on module RF-IMP cannot determine any imperfections because of missing re-
sults from RFEM or from modules RF-STABILITY or RF-DYNAM, it automatically calculates re-
levant deformations, stability modes or eigen vibrations during the following analysis. 

Type of Generation 
In principal, you can create imperfections in RF-IMP in two different ways. Select specific 
options in this section to activate or to deactivate them. 

Equivalent imperfections of members 
According to the standard DIN 18800, it creates a load case with equivalent imperfections 
of members or set of members. You can further use the load case in load groups. 

If you select this option for generation, additional data is required in the table sections 
Generated Imperfection Load Case and Options and in the table 1.2 Imperfections. 

Pre-deformed initial structure 
This option of generation transforms by scaling the standard deformations from RFEM, RF-
STABILITY or RF-DYNAM to the maximal ordinate of pre-deformation, which you determine. 
There are two different options for pre-deformed initial structures, which are suitable espe-
cially for big shells: 

• Generating of pre-deformed FE mesh  

For each FE node, RF-IMP determines a deformation which is located between zero and a 
maximal ordinate of pre-deformation. Before the second or the third order analysis, the FE 
mesh is shaped according to the relevant RF-IMP case. For this purpose, you should select 
the required RF-IMP case in a load group in RFEM. Structural data from RFEM will stay re-
tained. 

 
Figure 2.2: RFEM-Dialog box Edit Load Group, tab Calculation Parameters 
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• Generating of pre-deformed structure by shifting nodes only  

Contrary to the method described above, this option implicates changes of structural data. 
It moves coordinates of nodes in the RFEM-table 1.1 according to the determined deforma-
tion. Therefore, it is not necessary to apply the input data to load groups. 

This option of generation can consider one mode of imperfection only, because the nodes 
can be moved one time only. 

Generated imperfection load case 
This section is active only with selected type of generation Imperfections of members for 
RFEM Table 2.13. 

After generation, RF-IMP exports imperfections to the load case specified in the LC No. box. 
The first available number is set by default. You can directly enter Load case description or 
select it from the predefined list. 

After generation, a control question appears before final transferring data to RFEM. 

Options 
This section is also active only with selected type of generation Imperfections of members 
for RFEM Table 2.13. 

You can generate imperfections in a Governing direction or in Both local directions. If you 
select the first option (default setting), RF-IMP determines imperfections in one direction 
only, either in the direction of the local y-coordinate or z-coordinate of the member. Result-
ing deformation, resp. deflection of an eigenmode, will be stated according to the toler-
ance (compare chapter 3.1, page 16). This predefined tolerance is also considered in the 
case of generation in both local directions. 

By selecting the number of an existing load case in the section Generated imperfection load 
case, you activate two additional option buttons. You can select if RF-IMP Overwrites the 
existing load case or if RF-IMP Adds generated equivalent imperfections to the existing load 
case. 

Comment 
Use this box for user-defined remarks, for example to describe and interpret defined para-
meters for actual case of generation in RF-IMP. 

Click [Details] to control the tolerance settings for RF-IMP. The dialog box RF-IMP - Details, 
which is described later (chapter 3.1, page 16), appears. 
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2.2 Imperfections 
The second table of this add-on module is available only in the case of selected Imperfec-
tions of members for RFEM Table 2.13 in the previous table 1.1. 

The table 1.2 Imperfections is divided into two parts: upper part 1.2.1 Generate Imperfec-
tions of Members consider relevant members for generation, lower part 1.2.2 Generate Im-
perfections of Sets of Members takes into account the continuous members (groups of 
members are usually unsuitable for imperfections). 

Both parts of the table provide identical style of entering data. The only difference is that all 
input in the table 1.2.1 refers to particular members and the parameters of the table 1.2.2 
refer to sets of members. Because both parts are identical except this difference, they are 
described together later in the text. 

You can edit the input by standard key combinations, for example deleting an actual line by 
[CTRL+Y] (compare the RFEM program manual, chapter 4.4.8). 

Edit units and decimal places of lengths and loads in the main menu 

Options → Units and Decimal Places (compare the chapter 4.2, page 27). 

 
Figure 2.3: Table 1.2 Imperfections 

Generation imperfections of members or sets of members 
Determine member or set of member numbers in the column A. 

Please note, that you should have defined sets of members in the RFEM program to be able 
to select them in the RF-IMP add-on module. The RF-IMP add-on module does not allow you 
to create sets of members.  

Select members or sets of members graphically in the RFEM window after clicking the [Pick 
Members/Sets of Members] button. By clicking the cell in the table, you can alternatively 
enable the button […], which also runs the graphical selection.  

By picking members or sets of members in the RFEM workspace, you can transfer their 
numbers to the dialog box Multiple Selection. This dialog box allows you to return to RF-
IMP and to import the corresponding numbers into the add-on module. 
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Select all the members or set of members for generation by clicking the [Import All Mem-
bers] button. The members or set of members with identical parameters will be gathered in 
one line.  

It is not necessary to numerate the members in sets of members continuously. In addition, 
the orientation of members can also differ. However, the only requirement is that the rota-
tion of all the members in a set is the same. 

Inclination 
Specify parameters to define inclination in the columns from B through E. You can select 
one of the following options of definition: 

• DIN 18800 E-E (elastic-elastic method of analysis) 

• DIN 18800 E-P (elastic-plastic method of analysis) 

• EN 1992-1-1: 2004-12  (Eurocode 2) 

• EN 1993-1-1: 2005-07  (Eurocode 3) 

• DIN 1045-1: 2001-07 

• DIN 1052: 2004-08 

• Manually 

Definition option 
In the column B, select one of the options of definition described earlier in this chapter. 
Clicking the cell in the column B enables the [ ] button; use this button to select suitable 
definition from the list. You can also display the list of definitions by pressing the [F7] func-
tion key. 

RF-IMP automatically loads the values of an inclination 1/ϕ0 to the column E for both op-
tions of definition according to the standards. 

Length L 
Length L refers to the theoretical length of an imperfect member. This length is considered 
in the Equation 2.1 (see later in the text).  

In the column C, the member lengths are preset, but you can edit them where appropriate. 
Enable the […] button by clicking the cell in the column C. Use it for a graphical selection of 
the length in the RFEM workspace.  

n 
n refers to a number of self-existent imperfections of members or sets of members that 
should be considered. For example, see Figure 5 in the standard DIN 18800 Part 2, Para-
graph 2.3. Generally, you can set the n value as a number of frame columns in a floor in 
view of a frame plane. 

1/ϕ0 
If you select the option of definition Manually in the column B, directly enter the value of an 
inclination. Both columns Length L and n are inactive for this option.  

If you select one of the two options according to the standard DIN 18800, the automatic 
calculation of an inclination of one-part members usually proceeds according to the equa-
tion: 

210 rr
200
1

⋅⋅=ϕ  

Equation 2.1: Inclination ϕ0 according to DIN 18800 Part 2, Equation (1) 

This equation is based on the elastic-plastic method of analysis. Both reduction factors are 
determined as follows. 
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l
5

r1 =  

where  l: the theoretical length of a member or set of members 

Equation 2.2: Reduction factor r1 

Equation 2.2 is valid only for the lengths l ≥ 5.00 m. For l < 5.00 m, the value for r1 is 1. 

⎟⎟
⎠

⎞
⎜⎜
⎝

⎛
+⋅=

n
1

1
2
1

r2  

where  n: the number of the self-existent inclinations 

Equation 2.3: Reduction factor r2 

If you select the elastic-elastic method of analysis, the calculation proceeds the same way. 
However, according to the standard DIN 18800 Part 2, el. (201), the inclination can be re-
duced by 2/3 of its basis value (then ϕ0 = 1/300), because the stress design is based on the 
elastic-elastic method, for example as in the add-on module RF-STEEL. It takes into account 
the fact that the plastic reserve of the section is not fully used. 

In RF-IMP, the reduction is preset by default, because the elastic-elastic method of analysis 
represents a usual calculation method in programs from Dlubal company. 

Precamber 
You can Input parameters for precamber in the columns F and G. Select one of the follow-
ing options of definition: 

• DIN 18800 E-E according to BSC (buckling stress curve) 

• DIN 18800 E-P according to BSC 

• EN 1993-1-1 elastic 

• EN 1993-1-1 plastic 

• Selection of a precamber L/w0 

L/w0 
In the column F, you can select one of the options of definition, as listed above in the text. 
Enable the [ ] button by clicking the cell in the column F and use this button to select suit-
able definition from the list. You can also display the list of definitions by pressing the [F7] 
function key. 

The list contains usual values of a precamber according to the standards DIN 18800 and 
EN 1993-1-1, including two options EN 1993-1-1 Elastic and EN 1993-1-1 Plastic. The calcu-
lation of precamber according to the buckling stress curves is described in the standard 
EN 1993-1-1, chapter 5.3. For this option, you can find the values of a precamber for one-
part members in the standard EN 1993-1-1, chapter 5.3, Table 5.1. 

BSC 
The value of a precamber w0 

Elastic analysis Plastic analysis 

a0 L/350 L/300 

a L/300 L/250 

b L/250 L/200 

c L/200 L/150 

d L/150 L/100 

Table 2.1: The value of a precamber according to EN 1993-1-1, chapter 5.3, Table 5.1 
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An assignment of the buckling stress curves from a through d to the section types proceeds 
according to the standard EN 1993-1-1, chapter 6.3, Table 6.2 (see following Figure 2.4): 

 
Figure 2.4: Selection of buckling curve for a cross-section according to EN 1993-1-1, chapter 6.3, Table 6.2 

From ε0 
In the last column of the table, enter the value of a parameter ε0 which states the initial val-
ue for consideration of the precamber together with the inclination. According to the stan-
dard DIN 18800 Part 2, el. (207), the value of ε0 = 1.6 is set by default as it is the condition 
of a relevant precamber. However, you can define parameters or select them by clicking the 
[ ] button in the cell.  

The program RFEM calculates these parameters for different members or sets of members 
by the second order theory and then it compares them with the initial values. If it is neces-
sary, it also takes into account a precamber in following processes. 
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3. Generating 
This chapter describes the creation of imperfections by generating equivalent loads or a pre-
deformed initial structure and the following transferring of the results to the RFEM pro-
gram.   

3.1 Starting Generation 
Before generation, we recommend you to check the settings of tolerances in RF-IMP. Click 
the [Details] button in the table 1.1 General Data. The following dialog box appears:  

 
Figure 3.1: Dialog box RF-IMP - Details 

In the Tolerance of Member Imperfections section, set the ordinate of the selected defor-
mation mode or buckling shape that induces imperfections. Therefore, small deflections, 
which are less than the defined value, are not considered in the deformation mode or the 
buckling shape. No imperfections are generated for the members and the sets of members 
with deflections less than the defined limit. 

Set the value of the tolerance in a list that appears after clicking the [ ] button. You can 
select a value from e-1 through e-9. In the list, e-1 represents rounding off to one decimal 
place and selection of e-9 takes into consideration nine decimal places. 

RF-IMP examines normed shifts of nodes in the deformation mode or buckling shape. Max-
imal values refer to the normed value of 1. For example, if the maximal deformation of your 
structure is 10 cm, which is referring to the normed value of 1, then the normed value of 
0.008 represents the deflection of 0.08 cm. If you set the tolerance to e-3 (it means the 
rounding off to three decimal places: to 0.005) RF-IMP generates an equivalent imperfec-
tion for the member, because the normed value is greater than the limit. If the tolerance is 
set to e-2, imperfections of the member are not taken into account, because its normed 
value of deformation is less than the limit with two decimal places 0.05.  

In case RF-IMP cannot generate any imperfections of members because of the tolerance set-
tings, the corresponding warning appears after clicking the [Generate] button. 

 
Figure 3.2: Warning because of a too low value of a tolerance 

Increase the tolerance by taking into account more decimal places, as described above. 

This dialog box does not influence the generation of pre-deformed initial structures.  



3  Generating 

 17Program RF-IMP © 2010 Dlubal Engingeering Software 

 

 
 

 
 

  

In the both RF-IMP tables, the button [Generate] is available for data generation of a new 
load case or of a pre-deformed initial structure for RFEM. 

You can also start the generation in RF-IMP from the RFEM workspace. Find RF-IMP listed as 
an add-on module in the dialog box To Calculate, analogously to a load case or a load 
group. Start this dialog box from the RFEM main menu 

Calculate → To Calculate. 

 
Figure 3.3: Dialog box To Calculate 

If RF-IMP is missing in the list of Not Calculated cases, select the check box Show Additional 
Modules. 

Add selected cases from RF-IMP to the list on the right by the [ ] button and start the cal-
culation by clicking the [Calculate] button. 

You can also calculate a selected case of generation imperfections directly from the list in 
the toolbar. Select the required case from RF-IMP and click the button [Results on/off]. 

 
Figure 3.4: Direct approach to the calculation of a case of generation from RF-IMP in the RFEM program 

If you create the pre-deformed initial structure with the option Generating of pre-deformed 
structure by shifting nodes only based on already calculated Deformation from RFEM, a 
question about deleting the results appears.  

 
Figure 3.5: Question about deleting the results 
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If you agree to continue, RF-IMP changes the original structure. Deformations which are al-
ready calculated are wrong in this case. 

Depending on the structural data, the generation of imperfections or pre-deformed initial 
structure takes a very short time. After a successful generation, the table 2.1 Pre-deformed 
Initial Structure or Imperfections of members, sets of members or surfaces with FE mesh 
points appears (see Figure 3.2 and Figure 3.4). If you create a pre-deformed initial structure 
by shifting nodes, correspondent information appears. 

 
Figure 3.1: Information after successful generation of a pre-deformed initial structure  

The generation of imperfections or a pre-deformed initial structure is already finished. If you 
have defined more cases in RF-IMP, you must proceed a generation for each RF-IMP case 
separately. 

If you calculate all cases at once by clicking the command 

Calculate → Calculate All, 

RFEM considers all its load cases and all load cases from add-on modules. Defined cases 
from RF-IMP with the type of generation Imperfections of members for RFEM Table 2.13 are 
also calculated. However, RFEM does not automatically import the generated imperfections 
as a load case. Export them manually from the add-on module RF-IMP. Cases in RF-IMP with 
the type of generation Pre-deformed initial structure are omitted in global calculation. If 
they were calculated, all other results would be deleted and the calculation would be re-
jected. 
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3.2 Generated Imperfections 
The results output of generation differs for imperfections and for a pre-deformed initial 
structure. The type of this table depends on the type of generation imperfections. 

3.2.1 Equivalent imperfections 

 
Figure 3.2: Table 2.1 Imperfections 

After the generation, the two-part table 2.1 Imperfections appears. In both table sections, 
you find particular members or sets of members with generated imperfections. A direction 
of an action of inclination and a precamber are defined in a local coordinate system in the 
column B. 

Tension members and tension sets of members are not considered in generation of imper-
fections. 

You cannot edit the generated imperfections in this table. 

Click the [Graphic] button to display generated imperfections in the RFEM workspace. You 
can control now, if imperfections are generated for all the members and sets of members 
that are endangered by buckling. 
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Figure 3.3: Graphic with generated equivalent imperfections 

Click the [RF-IMP] button to return to the RF-IMP module, where you can eventually edit the 
input data or start a new generation process.  

3.2.2 Pre-deformed initial structure  

Generating of pre-deformed FE mesh 

 
Figure 3.4: Table 2.1 Pre-deformed Initial Structure 
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For the type of generation Generating of pre-deformed FE mesh, the two-part table 2.1 
Pre-deformed initial structure appears. In both tables, you can find the original locations 
and generated pre-deformations of FE mesh points for particular surfaces and members. 
Displayed pre-deformations are defined in the global coordinate system XYZ. 

Find a short example of creation of a pre-deformed initial structure starting from the page 
23, chapter 3.4.  

Generating of pre-deformed structure by shifting nodes 
Before generation of pre-deformed structure by shifting nodes, information that you need 
to convert plane surfaces into quadrangle surfaces appears. This is necessary for fitting the 
boundary lines of surfaces to a deformation shape or a buckling mode. 

 
Figure 3.5: Information about an existence of plane surfaces or conic sections  

After generation, the information that is displayed in the Figure 3.1 appears. It means that 
the deformation of an original structural system just proceeded. The generation is already 
finished. 

In a pre-deformed initial structure, the coordinates of nodes are modified. Close the RF-IMP 
module by clicking the [OK] or the [Cancel] button to control the modified coordinates, for 
example in the RFEM table 1.1 Nodes. Take into account that it is not possible to change 
the center of members or surfaces, only the coordinates of boundary nodes are shifted.  
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3.3 Exporting Imperfections 
This chapter describes exporting of generated imperfections as a load case to the RFEM 
program. In contrast, RF-IMP creates a pre-deformed initial structure automatically for 
RFEM and provides it to load groups (compare Figure 2.2, page 10) or it modifies coordi-
nates of nodes in the RFEM table 1.1 Nodes. 

You can export generated equivalent imperfections by clicking [OK] in any of the RF-IMP 
tables. The following information appears. 

 
Figure 3.6: Question about data exportation of imperfections as a load case 

As displayed in the Figure 3.3, you can also transfer the data in the RFEM graphical work-
space. Click the button [Export to LC...] in the panel and the same question, as described 
above, appears.  

 
Figure 3.7: Panel with the Export button 

After exporting imperfections, you will find the transferred data in the RFEM table 2.13 
Imperfections where you can edit or complete it eventually. 



3  Generating 

 23Program RF-IMP © 2010 Dlubal Engingeering Software 

3.4 Example: Pre-Deformed Initial Structure  
In this example, you can follow a generation of imperfections as a pre-deformed initial 
structure of a cupola structure that is modeled in the RFEM program. You should determine 
the initial deformation of FE mesh using a buckling mode to take into account buckling of 
surfaces.  

 
Figure 3.8: Model of a cupola and its buckling mode 

In the module RF-STABILITY, stability modes are based on a self-weight of structure.  

Open the RF-IMP table 1.1 General Data and enter the following input. 

 
Figure 3.9: RF-IMP table 1.1 General Data 
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The third buckling shape is set in the No. box. Enter the value of the Maximal ordinate of 
pre-deformation of 50 mm, then the normed values of deformation will be summed with 
the coordinates of FE nodes. Input is now complete. 

Click the [Generate] button to display modified FE nodes of surfaces in the table. 

 
Figure 3.10: RF-IMP table 2.1 Pre-deformed Initial Structure  

Click the [Graphic] button for a visual control of imperfections. 

Create a new load group and select Apply generated imperfections in the New Load Group 
dialog box, Calculation Parameters tab. 

 
Figure 3.11: Dialog box New Load Group, the tab Calculation Parameters 
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4. General Functions 
This chapter finally presents other menu options and options for exporting cases of genera-
tion. 

4.1 Cases of Generation with RF-IMP  
You can group the parameters or members and sets of members in separated cases of gen-
eration. This way, you can apply the generation of particular cases in RF-IMP on certain 
members, loads or buckling shapes. It is possible, that critical buckling shape differs in some 
part of the structure. Consider separately all the possibilities in dependence on your tech-
nical background. 

Be careful not to rewrite existing cases and their parameters for generation by entering a 
case number that is already used, while you are defining different cases of generation.   

Creating new cases in RF-IMP 
Create a new case of generation by clicking the command in the RF-IMP menu 

File → New Case. 

The following dialog box appears. 

 
Figure 4.1: Dialog box New RF-IMP-Case 

Enter an unassigned number to the No. box and type a Description of a new case of gener-
ation. By pressing [OK], display the table 1.1 General Data in RF-IMP for definition of new 
parameters. 

Renaming RF-IMP cases 
Edit the name of a case of generation by clicking the command in the RF-IMP menu 

File → Rename Case. 

The Rename RF-IMP-Case dialog box appears. 

 
Figure 4.2: Dialog box Rename RF-IMP-Case 
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Copying RF-IMP cases 
You can copy input data of an actual case of generation by clicking the command in the RF-
IMP menu 

File → Copy Case. 

The dialog box Copy RF-IMP-Case appears. Specify the No. and the Description of a new 
case.  

 
Figure 4.3: Dialog box Copy RF-IMP-Case 

Deleting RF-IMP cases 
You can delete a case of generation by clicking the command in the RF-IMP menu 

File → Delete Case. 

Select the case of generation in the list of Available Cases in the dialog box Delete Cases 
and press [OK] to delete it.  

 
Figure 4.4: Dialog box Delete Cases 
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4.2 Units and Decimal Places 
Manage units and decimal places in one global dialog box for RFEM and all add-on mod-
ules. Display this dialog box to control the units in RF-IMP by clicking the command 

Settings → Units and Decimal Places. 

The dialog box, already known from RFEM, appears, and the module RF-IMP is already se-
lected. 

 
Figure 4.5: Dialog box Units and Decimal Places 

You can save the parameters as your profile and reuse it for other structures. Find further 
description of these functions in the RFEM manual, chapter 12.6.2. 

4.3 Exporting Data 
Data from generated equivalent imperfections is exported directly to the main RFEM pro-
gram by creation of a new load case of imperfections. Eventually, it is possible to edit or 
complete the load case. For detailed description of transferring equivalent loads to RFEM 
see chapter 3.3, page 22. With some restrictions, you can also provide data directly from 
RF-IMP to other programs. 

Clipboard 
You can copy selected cells from the tables 1.2 Imperfections and 2.1 Pre-deformed Initial 
Structure or Imperfections by pressing the key combination [CTRL+C] and insert it by press-
ing [CTRL+V], for example into one of the text editors. Column headings are not taken into 
account. 
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Printout report 
You cannot directly add data from RF-IMP in the printout report. However, you can directly 
export imperfections as created RFEM load cases from the printout report by the command 

File → Export to RTF File or BauText. 

Find a description of this function in the RFEM manual, chapter 11.1.11. 

MS Excel / OpenOffice 
You can directly export data from RF-IMP to MS Excel or OpenOffice.org Calc. Use this func-
tion by clicking the command 

File → Export Tables. 

The following dialog for exporting appears. 

 
Figure 4.6: Dialog box Export - MS Excel 

In accordance with a conception, only the tables 1.2 Imperfections and 2.1 Pre-deformed 
Initial Structure or Imperfections are considered for exporting. Press [OK] to start exporting 
data. MS Excel starts automatically, its running in the background is not necessary. 

 
Figure 4.7: Result of exporting data to MS Excel 
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